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About This Manual

This manual provides information about installing and administering 
MATRIXx on a PC running Microsoft Windows XP/2000.

Conventions
The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names.

italic Italic text denotes variables, emphasis, a cross-reference, or an introduction 
to a key concept. Italic text also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames, and extensions.

monospace bold Bold text in this font denotes the messages and responses that the computer 
automatically prints to the screen. This font also emphasizes lines of code 
that are different from the other examples.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value 
that you must supply.
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Related Documentation
You might find the following resources helpful as you use this manual. 
These resources are available by selecting Help»MATRIXx Bookshelf.

• FLEXnet Licensing End User Guide

• MATRIXx Getting Started Guide

• SystemBuild User Guide

• Xmath User Guide
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1
System Requirements and 
Installation Overview

This chapter provides an overview of the system requirements for 
MATRIXx 8.x and information about installing MATRIXx.

System Requirements
Table 1-1 lists the system requirements for MATRIXx 8.x.

MATRIXx also has the following additional requirements:

• Microsoft Internet Explorer 6 or later is required to use the 
MATRIXx Help.

• Adobe Reader 7.0 or later is required to use the MATRIXx Bookshelf.

• (Optional) If you want to link external C code to Xmath or 
SystemBuild, you must install Microsoft Visual C++ 6.0. To link 
external FORTRAN code, you must install DIGITAL Visual 
Fortran 6.0.

Note National Instruments does not support using other compilers with MATRIXx.

Table 1-1.  MATRIXx System Requirements

Component Requirement

Operating 
System

Microsoft Windows XP/2000

CPU Pentium 4 or equivalent

RAM 512 MB, 1 GB recommended

Disk Space 188 MB for MATRIXx and/or 12 MB for the License 
Manager

Display 1024 × 768 pixels
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• (Optional) To use a floating license, a computer must be on a TCP/IP 
network.

Licensing
MATRIXx uses FLEXnet licensing utilities from Macrovision 
Corporation. For information about licensing, refer to the following 
resources:

• Chapter 3, Licensing and Terminology.

• Chapter 4, FLEXnet Licensing Tools.

• The FLEXnet Licensing End User Guide, available by selecting 
Help»MATRIXx Bookshelf.

Troubleshooting Information
For troubleshooting tips, refer to the Troubleshooting Installation 
section of Chapter 2, Installation and Related Tasks. For additional 
troubleshooting assistance, refer to the Technical Support and Professional 
Services appendix of this manual.

Software Structure
This section describes installation planning options and the directory 
structure of MATRIX.

Planning Options
Before starting the installation, you should make decisions about how and 
where you want to install MATRIXx tools. These issues must be addressed 
before you start the installation procedure detailed in Chapter 2, 
Installation and Related Tasks.

MATRIXx version 8.x must be installed in a different installation directory 
if you plan to keep versions prior to 6.x. The version 8.x installation will not 
affect an older version of MATRIXx software as long as you do not use the 
same parent directory. You do not have to do any extra work to keep the 
older version of MATRIXx, which will still use its own license manager.
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Directory Structure
The directory structure shown in Figure 1-1 shows the MATRIXx product 
structure, which enables you to manage the software in a central location in 
a network environment. You can safely install MATRIXx version 8.x into 
a shared installation directory with MATRIXx 7.1.x.

Note All machines that will use MATRIXx software must be able to access the 
%MTXHOME% root directory. %MTXHOME% and installation_directory (referred to 
elsewhere in this document) are equivalent.

The commands used to invoke the MATRIXx suite of products can be 
found in the %MTXHOME%\bin directory.

From the root installation directory (%MTXHOME%), the MATRIXx 
installation has the directory structure shown in Figure 1-1.

Figure 1-1.  MATRIXx Installation Directory Structure
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2
Installation and Related Tasks

This chapter describes how to install MATRIXx software and perform 
related tasks.

Installing MATRIXx 8.x
This section provides a detailed description of how to install MATRIXx 
product family version 8.x software on a standalone PC.

Complete the following steps before installing MATRIXx.

1. Obtain a reference number, authorization key, and checksum by 
sending an email to matrixx@ni.com. You need these items to 
complete the installation of MATRIXx.

2. Ensure the installation computer meets the system requirements as 
described in the System Requirements section of Chapter 1, System 
Requirements and Installation Overview.

3. Disable any virus-scanning software and close all programs on the 
installation computer.

Complete the following steps to install MATRIXx.

1. Insert the MATRIXx 8.x installation CD.

2. If the installation does not run automatically, run the setup.exe 
program.

3. Follow the instructions that appear on the screen.

4. When prompted to generate a new MATRIXx_PKG_080000.lic 
license file, click Yes if you do not already have a version 8.x license 
file. MATRIXx then prompts you for the reference number, 
authorization key, and checksum that you obtained from National 
Instruments.

If you intend to access a floating license file, click No. When the 
installation finishes, create a proxy license as described in the Proxy 
License Files section of Chapter 3, Licensing and Terminology.
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5. If you are installing redundant license servers, complete the procedure 
described in the Installing Redundant License Servers section of this 
chapter.

Note The license server is not required for an Evaluation license. For other licenses, 
the license server can always be started later using the following command: 

lmgrd -c license.dat -l debug.log

Installing Other Components
This section describes the installation procedures for installing optional 
MATRIXx components.

Installing the Standalone License Manager
The standalone license manager installation, which populates only the 
MATRIXxLicenseManager\ subdirectory tree, is a subset of the full 
MATRIXx installation. It can provide the required licensing installation on 
single or redundant license servers.

Before running the installation program, you will need the NI reference 
number, authorization key, and checksum. 

Complete the following steps to install the standalone license manager.

1. Insert the MATRIXx 8.x installation CD.

2. On the CD, browse to the MTXNILM directory.

3. Double-click setup.exe.

4. Select the Install License Manager setup type and follow the 
instructions that appear on the screen.

Each installation of MATRIXx installed in a separate location can access 
the license server via the proxy license file described in the Proxy License 
Files section of Chapter 3, Licensing and Terminology.

Installing Redundant License Servers
At a minimum, installing redundant license servers requires the installation 
of standalone license manager software and starting the license manager 
daemon on two other nodes in addition to the primary license server. 
Special license keys are required for a redundant license server 
configuration. 
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Complete the following steps to install a typical redundant license server 
configuration.

1. Perform a standalone license manager installation on the primary 
license server (refer to Installing the Standalone License Manager 
section) or a complete MATRIXx installation if you want this machine 
to also serve the MATRIXx application files (refer to the Installing 
MATRIXx 8.x section). Either procedure requires generating a license 
file and starting the license daemon.

2. On each of two secondary license servers, run either the standalone 
license manager installation (refer to the Installing the Standalone 
License Manager section) or a complete MATRIXx installation (if you 
want to replicate all the MATRIXx files), and then start the license 
daemon on each machine.

Note Rather than generating the license file on each secondary license server, copy 
MATRIXx_PKG_080000.lic from the MATRIXxLicenseManager\bin\ directory 
of the primary server to the MATRIXxLicenseManager\bin\ directory of each 
secondary server before starting the license daemons. Edit the DAEMON line of each 
secondary copy of the MATRIXx_PKG_080000.lic file to point to the daemon path that 
contains nilm.exe for that server.

Each separate installation of MATRIXx can access the license server with 
a proxy license file as described in the Proxy License Files section of 
Chapter 3, Licensing and Terminology.

Updating a License File
To update a license file, run the standalone license manager installation as 
described in the Installing the Standalone License Manager section of this 
chapter and select the Update License File setup type.

Installation-Related Tasks
This section provides information about tasks related to installing 
MATRIXx.

Setting Up a User Environment for Printing
The environment variable %XMATH_PRINT% defines the printer for 
MATRIXx. For information about defining environment variables, refer to 
the operating system documentation.
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Running Multiple MATRIXx Versions
You can install multiple versions of MATRIXx version 6.x or later under a 
common directory. If you have multiple versions installed, the following 
command lets you run a selected version:

installation_directory\bin\command_name -v version

where command_name is xmath, sbsim, autostar, ia, encrypt, 
matrixx, or mtxhelp, and version is one of the versions in 
installation_directory\bin. The version string appears as a 
suffix on the launching scripts.

Recording Your Reference Number
To help National Instruments provide rapid support when you call, 
the installation procedure prompts you for the 10-character 
reference number. Your reference number is stored in the file 
%MTXHOME%\MATRIXxLicenseManager\bin\config.txt. If you 
do not have a reference number, you can obtain one from National 
Instruments and enter it into the first line of the config.txt file as 
follows:

REFERENCE NUMBER: 10_character_string

You can use the Xmath NIREFNUM command to display the reference 
number. 

Moving the %MTXHOME% Directory Tree to Another Directory
If you want to move the %MTXHOME% directory tree to another directory 
after installing MATRIXx version 8.x, the preferred method is as follows:

1. Save the MATRIXx_PKG_080000.lic file (if required). 

2. Uninstall the MATRIXx software after stopping the license daemon.

3. Reinstall MATRIXx in the new directory location.

4. Copy the MATRIXx_PKG_080000.lic file to the new directory 
location.

5. Restart the license daemon.
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Troubleshooting Installation
The following sections provide some installation troubleshooting tips.

Temp Directory Usage During Install
InstallShield uses the Windows TEMP folder during installations. It is 
therefore important that sufficient disk space exist on the disk drive 
containing TEMP, which may be different from the drive where you are 
installing MATRIXx. An installation can fail when there is insufficient 
disk space on the TEMP drive. On rare occasions, an InstallShield install can 
fail due to remnants in the TEMP folder of a previously aborted install. You 
can avoid this problem by clearing the contents of the TEMP folder.

License Servers
The license server must be started unless you are using an Evaluation 
license or are using another network node as a floating license server. When 
the license server is properly started, the lmgrd and nilm processes 
should appear in the process list of the Windows task manager. You can 
use the MATRIXx License Server applet in the Windows Control Panel 
to start or stop the license server or to check its status. You can also 
check the contents of the license server diagnostic log file, 
installation_directory\MATRIXxLicenseManager\bin\
debug.log, to see if the license server is running correctly. If the license 
server is running and you wish to use a different copy of the 
MATRIXx_PKG_080000.lic file, you should stop the license server 
first, copy the new MATRIXx_PKG_080000.lic file and then restart the 
license server.
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If you try to perform one of the following licensing tasks and receive an 
error message, you may be able to correct it by identifying the cause as 
described in Table 2-1.

Uninstalling MATRIXx
You uninstall both the MATRIXx product and the MATRIXx License 
Server by using the Windows Control Panel. The uninstallation process 
depends on the licensing configuration you use.

If you installed MATRIXx using a node-locked license, you need to 
uninstall only the MATRIXx product. However, if MATRIXx 
communicates with a license server over a network, or if you installed the 
standalone license server, you must uninstall the MATRIXx License Server 
separately from the MATRIXx product. For information about the licensing 
configurations, refer to the Licensing Overview section of Chapter 3, 
Licensing and Terminology.

Caution Uninstalling the License Server can disrupt the functionality of other National 
Instruments products on the same computer that depend on a License Server. For example, 
NI LabVIEW Remote Panels and the NI Volume License Manager depend on a License 
Server. If these products are on the same computer as the MATRIXx License Server, 
National Instruments recommends you do not uninstall the MATRIXx License Server.

Table 2-1.  Error Message Definitions

Command Error Message or Problem Cause or Remedy

lmdiag lmdiag reports that the host 
ID is correct, but the license 
daemon has not been started.

Kill all lmgrd processes 
started for the 
MATRIXx_PKG_080000.
lic file (they are trying to 
use the same TCP/IP port) 
and start a new lmgrd 
process.

lmreread -c license_file You cannot use lmreread 
to change server node names 
or port numbers.

You have changed the 
server name or port 
number. Kill the old 
daemon, then restart the 
license daemon.
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If you are uninstalling both the License Server and the MATRIXx product, 
National Instruments recommends you uninstall the License Server before 
uninstalling the MATRIXx product.

Before uninstalling the License Server, you must stop the License Server 
service. Complete the following steps to stop this service.

1. Select Start»All Programs»National Instruments»MATRIXx 
License Manager 8.x»LMtools. This action launches the 
LMTOOLS dialog box.

2. Click the Start/Stop/Reread tab.

3. Click Stop Server. If this tool returns an error, the server might be 
stopped already.

4. Click the Config Services tab.

5. Click Remove Service.

6. Close the LMTOOLS dialog box. 

You can now uninstall the MATRIXx License Server and then the 
MATRIXx product.
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3
Licensing and Terminology

National Instruments uses the FLEXnet license manager, a product of 
Macrovision Corporation, to run the MATRIXx License Server. This server 
consists of the following two files, known as daemons, that administer 
licenses.

• License manager daemon—lmgrd.exe

• Vendor daemon—nilm.exe

These files are located in the %MTXHOME%\MATRIXxLicenseManager\
bin\ directory. Depending on the licensing configuration, these files must 
be running on the license server. This server can be either the installation 
computer or a remote computer. The License Server also includes tools to 
administer and use the license.

This chapter provides information about licensing and describes 
licensing-related terminology and tasks. If you have license manager 
questions beyond the scope of this document, refer to the 
FLEXnet Licensing End User Guide, available by launching MATRIXx 
and selecting Help»MATRIXx Bookshelf.

Licensing Overview
MATRIXx licensing supports the following configurations:

• Floating and node-locked licenses

• Redundant license servers (optional)

• Flexible license checkout

The following sections provide information about these configurations.
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Floating and Node-Locked Licenses
License configurations for counted floating licenses, node-locked licenses, 
and evaluation licenses are available on Windows XP/2000 systems. To 
check out a floating license or counted node-locked licenses, a client 
system must be connected to a TCP/IP network. Evaluation and uncounted 
node-locked licenses do not require that you have a running license server 
or network support.

Windows XP/2000 systems can check out floating licenses from either a 
Windows XP/2000, Solaris, or Linux license server. To check out licenses 
from a network license server, a Windows system must reference a copy of 
the same MATRIXx_PKG_080000.lic file used by the network server, or 
it must reference a proxy license file (refer to the Proxy License Files 
section).

Redundant License Servers 
Redundant license servers are a set of three nodes designated to serve 
the same license file. If any node fails, the other two nodes will still be 
available to serve the licenses for MATRIXx. 

To support the redundant license server scheme, National Instruments 
requires the computer name and host ID for the three servers. Windows 
XP/2000 systems can check out floating licenses from redundant systems 
containing any combination of Windows, Solaris, and Linux servers.

NI issues redundant license server keys after you provide the host ID of the 
three servers. At a minimum, you need to run the standalone license server 
installation program and start the license server on each machine. Follow 
the instructions described in the Installing Redundant License Servers 
section of Chapter 2, Installation and Related Tasks. 
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Figure 3-1 shows a typical redundant license-server configuration. 

Figure 3-1.  Typical Redundant License Server Configuration

Flexible License Checkout
With MATRIXx version 8.x licensing, a feature (product component) is 
checked out as you use it. A feature stays checked out until you exit that 
product component. For example, Xmath is checked out when first used 
and stays checked out until you exit Xmath. SystemBuild is checked out 
when you create or load a project and stays checked out until you close all 
projects. The flexible license checkout feature is also known as on-demand 
checkout.

Xmath Licensing Commands
Xmath has the following license-related commands:

• LICENSECHECKOUT for checking out features for future use.

• LICENSEUSER for displaying assigned licenses for any feature names 
specified.

• LICENSEINFO for displaying a license report for your site.

• LICENSEFILE for displaying the current license file search path.

• NIREFNUM for identifying your reference number.

All of these commands must be run from the Xmath Commands window. 
The following sections provide information about these commands.

%MTXHOME%
license.dat

%MTXHOME%
license.dat

%ISIHOME%
license.dat

Windows Server One or More Client or Standalone Systems

Windows ServerWindows Server
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LICENSECHECKOUT
LICENSECHECKOUT is an intrinsic command that checks out a license for 
the listed feature or features. Run LICENSEINFO to see a list of feature 
names. Features are specified as strings, and the name must be exactly as 
displayed by LICENSEINFO.

Although features are normally checked out on-demand, you can use 
LICENSECHECKOUT to reserve features for future use (for example, for a 
scheduled demo or presentation). They are checked in when you exit 
Xmath.

This command can be placed in a global or local startup.ms file to 
check out required features at startup. The syntax is as follows:

LICENSECHECKOUT feature1,feature2,...featureN

For example:

LICENSECHECKOUT "Xmath","Control","Sysid","Sysid2",

"sysbld","case"

LICENSEUSER
The LICENSEUSER utility displays assigned licenses for any feature 
names specified. The default feature is Xmath if no argument is specified. 
LICENSEUSER accepts feature names in string form. To see a list of the 
feature names for products you have purchased (for example, aca indicates 
AutoCode Ada), issue the LICENSEINFO command. The syntax for 
LICENSEUSER is as follows:

LICENSEUSER feature1,feature2,...featureN

For example:

LICENSEUSER "xmath","aca"

LICENSEINFO
LICENSEINFO displays a license report for your site.

LICENSEFILE
The LICENSEFILE command displays the current license file search path. 
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NIREFNUM
The NIREFNUM command displays the reference number, which is also 
known as the customer identification number. You should have this 
number ready if you plan to call customer support.

Using Licensing
With concurrent licensing, you can have a different number of licenses for 
each module or application. An application or module is either available on 
a first-come, first served basis, or node-locked to a given CPU. Some 
common uses of licensing are as follows:

• To see all the features your site has purchased or to view the license 
expiration date, use the command LICENSEINFO.

• To see who is using a given feature, or to see if a feature is available, 
use the LICENSEUSER command and specify the desired feature.

• To see the current license file search path, use the command 
LICENSEFILE.

• To reserve features for future use (for example, for a scheduled demo 
or presentation), use the LICENSECHECKOUT feature. 

The initial distribution of licenses is determined at the time of the 
installation; to change licensing, your system administrator must get a new 
key from National Instruments. To generate a new license file from this key, 
run the standalone license installation as described in the Updating a 
License File section of Chapter 2, Installation and Related Tasks.

License Files
The set of licensed features available for checkout by a MATRIXx user are 
contained in one or more license files, each containing encrypted feature 
lines. 

The following default license files are used by the MATRIXx products:

• \Licenses\MATRIXx_PKG_080000.lic—This primary license 
file contains feature lines for built-in MATRIXx features. This file is 
generated during the installation process and uses the authorization 
information you obtain from National Instruments.
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• \Licenses\tplic.dat—This optional file contains license feature 
lines for third-party MATRIXx components. The encrypted feature 
lines in this file and the instructions for using the file will typically 
be provided by your third-party supplier. Multiple features from 
different third-party suppliers can be placed in this file. Typically, 
this file will also contain the same SERVER and DAEMON lines as 
MATRIXx_PKG_080000.lic. This file is not modified during a 
MATRIXx or license manager installation, nor is it deleted by uninstall 
procedures.

The search paths used to locate these license files are set in the environment 
variable %NILM_LICENSE_FILE% by the MATRIXx product launching 
scripts. The above NI license file paths are prepended to any existing 
definition of %NILM_LICENSE_FILE%, thus allowing access to other 
MATRIXx or non-MATRIXx products also licensed by a FLEXnet license 
manager.

Normally, you can change only the following items in a license file.

• The host name (not the host ID).

• The port number on the SERVER line. If this port number is already in 
use, the license daemon lmgrd will report Address In Use. The 
default port number used in MATRIXx 8.x license files is 27011. A 
valid number is any unused port number between 1025 and 64000. 

The port number can be removed, and the FLEXnet license manager 
will serve on any available FLEXnet reserved port in the range 
27000–27009. For redundant license servers, however, you must use 
a fixed port number.

• The path to the vendor daemon executable on the DAEMON line. The 
vendor daemon is named nilm.

• name=value pairs on a FEATURE line can be changed if name is 
lowercase.

Redundant license server files contain three SERVER lines. The first 
SERVER line defines the primary license server. The second and third lines 
define the secondary license servers.

Proxy License Files
If you are using a floating-license server, each licensing client needs a copy 
of the same license file used by the server. Alternatively, to avoid copying 
the license server file to each installation of MATRIXx, you can create a 
proxy license file in the MATRIXxLicenseManager\bin\ directory of 
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each MATRIXx installation. This approach can be used for both single 
and redundant license server configurations. The proxy license file 
MATRIXx_PKG_080000.lic can be constructed by taking the SERVER 
line or lines from the license server file and then adding a line containing 
USE_SERVER. For example, a proxy license file for a single server 
configuration would be as follows:

SERVER host1 17003456 27011

USE_SERVER

A proxy license file for a redundant server configuration, for example, 
would be:

SERVER host1 17003456 27002

SERVER host2 17004355 27002

SERVER host3 17007ea8 27002

USE_SERVER

Unless your server nodes are changed, you will not have to update the 
license file for each individual MATRIXx installation when the server 
license file is updated.

Although a proxy license file is the preferred way to reference the actual 
license file used by a remote license server, you can also use a port@host 
definition for either of the environment variables NILM_LICENSE_FILE, 
where port is the license file port number and host is the hostname. Both 
are taken from the SERVER line of the actual license file.

The MATRIXx 8.x license manager uses the vendor daemon name nilm 
and the default port number 27011. Because earlier versions of MATRIXx 
use different vendor daemon names and port numbers, you can install 
multiple licensed versions of MATRIXx on the same computer. The 
MATRIXx 6.x (ISILM) and MATRIXx 8.x (NILM) license manager 
can coexist with MATRIXx 5.x running on the same machine.  Since 
version 6.x/8.x software must be installed in a different %MTXHOME% 
directory than MATRIXx 5.x, versions of the MATRIXx license manager 
for MATRIXx 5.x do not have to be stopped to install the new software. 
MATRIXx 6.x (ISILM) and MATRIXx 8.x (NILM) can share the same 
%MTXHOME% directory since their license directories are different. You need 
to kill the older license manager daemon (lmgrd) only if you choose to 
remove the old software.

Note Because of the addition of new features and new license manager functionality, 
license keys issued prior to MATRIXx 8.x cannot be used to regenerate a license file for 
version 8.x.
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Licensing Requirements
In order to obtain a license, you must provide the computer name and host 
ID for each license server machine. 

Finding the Computer Name
The computer name is defined at the time Windows is installed. For 
information about finding the computer name, refer to the operating system 
documentation.

Finding the Host ID
FLEXnet uses different machine identifications for different machine 
architectures. An Ethernet address is the preferred “host ID” for a Windows 
platform. An Ethernet address is a 6-byte quantity, with each byte specified 
as two hexadecimal digits. Specify all 12 hex digits when using an Ethernet 
address as a host ID.

The program %MTXHOME%\MATRIXxLicenseManager\bin\
lmhostid displays the Ethernet host ID that FLEXnet expects to use on 
any given machine. For floating licenses, you must provide an Ethernet 
address. For node-locked licenses, an Ethernet address is preferred, but a 
disk volume serial number for drive C: can be used. A disk volume serial 
number is an eight-character string with the dash omitted.

For information about finding the Ethernet address of a computer, refer to 
the operating system documentation.
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4
FLEXnet Licensing Tools

This chapter describes the FLEXnet utilities. This includes explaining how 
to troubleshoot common license manager problems and describes messages 
from the daemon log file. For more information about licensing, refer to the 
FLEXnet Licensing End User Guide, available by launching MATRIXx 
and selecting Help»MATRIXx Bookshelf.

FLEXnet Utilities
MATRIXx Product Family version 8.x uses FLEXnet for its license server. 
FLEXnet provides the following utilities to help manage the licensing 
activities on the network.

• lmgrd—Starts the license daemon.

• lmstat—Helps you monitor the status of all network licensing 
activities.

• lmreread—Causes the license daemon to reread the license file and 
start any new vendor daemons.

• lmhostid—Reports the host ID of a system.

• lmdiag—Lets you diagnose problems when you cannot check out 
a license.

• lmver—Reports the FLEXnet version of a library or a binary.

• lmborrow—Supports license borrowing.

• lmutil—FLEXnet license server management and administration.

• lmtools—Graphical user interface for FLEXnet utilities.

These commands are located in the 
%MTXHOME%\MATRIXxLicenseManager\bin\ directory. The following 
sections provide information about each of these commands.



Chapter 4 FLEXnet Licensing Tools

System Administrator Guide (Windows) 4-2 ni.com

lmgrd
lmgrd is the main daemon program for FLEXnet. When you invoke 
lmgrd, it looks for the license file. The license file contains information 
about vendors and features. 

The syntax is:

lmgrd -app [ -c license_file ] [ -t timeout ] 

[ -s interval ] [ -b ] [ -l logfile ]

where:

lmstat
The lmstat utility helps you monitor the status of all network licensing 
activities, including:

• Which daemons are running

• Users of individual features

• Users of features served by a specific daemon

Syntax is:

lmstat [-a] [-S [DAEMON]] [-f [feature]] 

[-s [server_name]] [-t value] [-c license_file][-A] 

[-l [regular expression]

-app Is required for Windows systems. 

-c license_file Uses the specified license file. 

-t timeout Sets a timeout interval, in seconds, during 
which redundant daemons must complete their 
connections to each other. The default value is 
10 seconds. A larger value may be desirable if 
the daemons are being run on busy systems or a 
heavily loaded network.

 -s interval Specifies the logfile timestamp interval, 
in minutes. The default is 360 minutes.

-l logfile Specifies the pathname to the log file. If this 
option is not specified, the log will be sent to 
standard output.

-v Prints the lmgrd version number.
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where:

lmreread
The lmreread utility causes the license daemon to reread the license file 
and start any new vendor daemons that have been added. Additionally, all 
pre-existing daemons will be signaled to reread the license file for changes 
in feature licensing information. Syntax is:

lmreread [-c license_file]

Note If you use the -c option, the license file specified will be read by lmreread, not by 
lmgrd; lmgrd rereads the file it read originally. Also, lmreread cannot be used to change 
server node names or port numbers. Vendor daemons will not reread their option files as a 
result of lmreread.

lmhostid
The lmhostid utility reports the host ID of a system. Syntax is:

lmhostid [ether | long]

The output of this command appears as follows:

lmhostid - Copyright (c) 1989, 199x Highland Software, 

Inc. The FLEXnet host ID of this machine is "69021c89"

The ether option causes lmhostid to print the Ethernet address on 
Hewlett-Packard (HP) systems. On HP systems the long option prints 
the value of the HP ID module. These options are only available in 

-a Displays everything.

-A Lists all active licenses.

-c license_file Uses license_file.

-S [DAEMON] Lists all users of the specified daemon’s 
features.

-f [feature_name] Lists users of the specified feature(s).

-l [regular 
expression]

Lists users of matching license(s).

-s [server_name] Displays status of server node(s).

-t value Sets lmstat time-out to value.
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FLEXnet v2.21 or later. The default is long for FLEXnet v2.21 or earlier, 
and ether for FLEXnet v2.4 or later.

lmdiag
lmdiag allows you to diagnose problems when you cannot check out a 
license.

Usage is: 

lmdiag [-c license_file] [-n] [feature]

where -c license_file path to file to diagnose. -n run in 
noninteractive mode; lmdiag will not prompt for any input in this mode. 
In this mode, extended connection diagnostics are not available. Feature 
diagnose this feature only. 

If no feature is specified, lmdiag will operate on all features in the license 
file(s) in your path. lmdiag will first print information about the license, 
then attempt to check out each license. If the checkout succeeds, lmdiag 
will indicate this. If the checkout fails, lmdiag will give you the reason for 
the failure. If the checkout fails because lmdiag cannot connect to the 
license server, then you have the option of running “extended connection 
diagnostics.” 

These extended diagnostics attempt to connect to each port on the license 
server node, and can detect if the port number in the license file is incorrect. 
lmdiag will indicate each port number that is listening, and if it is an 
lmdiag process, lmdiag will indicate this as well. If lmdiag finds the 
vendor daemon for the feature being tested, then it will indicate the correct 
port number for the license file to correct the problem. 

lmver
lmver reports the FLEXnet version of a library in binary. Usage is:

lmver [filename]

where filename can be nilm.exe or lmgrd.exe.
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lmborrow
lmborrow supports borrowing of licenses that contain the BORROW 
attribute. It must be run on the machine where licenses are borrowed. It is 
used to perform the following:

• Initiating borrowing by setting the borrow period

• Clearing the borrow period

• Determining borrow status

• Returning a borrowed license early

Initiating Borrowing
To initiate borrowing, the user sets the borrow period by running 
lmborrow from the command line or through LMTOOLS:

lmborrow {vendor | all} enddate [time]

where:

For example:

lmborrow sampled 20-aug-2001 13:00

This command has the effect of setting LM_BORROW with the borrow period 
in either registry.

To borrow licenses for the desired vendor, on the same day and the same 
machine that the user runs lmborrow, run the application(s) to check out 
the license(s). If you run the application(s) more than once that day, no 
duplicate licenses are borrowed. No licenses are borrowed if the application 
is run on a day different than the date borrowing is initiated. 

vendor The vendor daemon name that serves the 
licenses to be borrowed, or all specifies all 
vendor daemons in that license server.

enddate [time] Date the license is to be returned in 
dd-mmm-yyyy format. time is optional and 
is specified in 24-hour format (hh:mm) in the 
FLEXnet-licensed application’s local time. 
If time is unspecified, the checkout lasts 
until the end of the given end date.
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In addition to the lmborrow utility, there are other ways to initiate 
borrowing: 

• Using the borrowing interface in application, if provided in the 
application. 

• Setting the LM_BORROW environment variable directly.

Clearing the Borrowed License Setting
To clear the LM_BORROW setting in the registry issue the command:

lmborrow -clear

Clearing the LM_BORROW setting stops licenses from being borrowed until 
borrowing is initiated again. A user might run lmborrow -clear after 
he has borrowed licenses for features that are used offline if—before 
disconnecting from the network—he wants to run an application that 
checks out additional features, served by vendor, that are not meant to 
be borrowed. Clearing LM_BORROW does not change the status for 
already-borrowed licenses.

Determining Borrowed License Status
To print information about borrowed features, issue the following 
command on the machine from which they are borrowed:

lmborrow -status

The borrowing system does not have to be connected to the network to 
determine the status.

Returning a Borrowed License Early
To return a borrowed license early, first reconnect the borrowing system 
back to the network and then, from the same machine that initiated the 
borrowing, issue the command:

lmborrow -return [-c license_file_list]

[-d display] feature

where:

-c licesne_file_list Use the specified license file(s). In some 
configurations, the license file needs to be 
specified in order to return the license file 
early.
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Returning the license early has the effect of clearing the LM_BORROW 
setting for the vendor daemon that serves the returned license. 

If the borrowing system is not placed back on the network before 
attempting the early return, the license is not returned and LM_BORROW 
is kept intact. Additionally, an error message is issued to the end user with 
notification that the system needs to be connected to the network.

lmutil
The following are valid arguments for most lmutil utilities:

-d display Used to specify the display from which 
the borrow was initiated. Required if you 
current display is different than what was 
used to initiate the borrow. On Windows, 
it is the system name or, in the case of a 
terminal server environment, the terminal 
server client name.

feature The name of the borrowed feature to be 
returned early. Use lmborrow -status 
to get a list of borrowed feature names.

-c license_file_path Most lmutil utilities need to know the 
path to the license file. This is specified 
with a -c license_file_path 
argument, or by setting the 
LM_LICENSE_FILE environment 
variable. Otherwise, the default location 
is used. The utilities also honor all 
VENDOR_LICENSE_FILE environment 
variables. Some utilities take more than 
one license file path in a license-file list 
separated by semi-colons. Pathnames 
which include spaces have to be enclosed 
in double quotes.

-v Prints the FLEXnet version of the utility.

-verbose Prints the description for all errors found. 
The output from the utilities may be 
harder to read with this option, but is 
useful for diagnostics. (v6.0+ only)
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lmtools
For the 32-bit Windows platforms, a graphical user interface to the license 
manager tools is provided called LMTOOLS. Always use the newest 
version of LMTOOLS as possible; it is available for download from 
www.macrovision.com.

Some of the functions LMTOOLS performs include:

• Starting, stopping, and configuring FLEXnet license servers

• Getting system information, including hostids

• Getting server status

LMTOOLS has two modes in which to configure a license server:

• Configuration using a license file

• Configuration using services

Configuration Using License File
Operations are performed on a particular license file. The file can be either 
local or remote. In this mode, you cannot start the lmgrd process, but you 
can do everything else. To configure this mode, perform the following:

1. Invoke LMTOOLS.

2. Click the Configuration using License File radio button.

3. Enter one or more the license file names or port@host specifications.

Configuration Using Services
Operations are performed on a service, which allows starting lmgrd 
processes local to the system on which LMTOOLS is running. On 
XP/2000, you configure a Windows Service.

Resolving Problems
This section offers some general debugging tips, and discusses information 
you should gather before contacting support. The Troubleshooting License 
Manager Problems section lists common license manager problems users 
have encountered before.
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General Debugging Tips
The following are tips for debugging:

• Examine the 
%MTXHOME%\MATRIXxLicenseManager\bin\debug.log file.

• If you cannot check out a feature, run:

%MTXHOME%\MATRIXxLicenseManager\bin\lmdiag -c 
%MTXHOME%\MATRIXxLicenseManager\Licenses\
MATRIXx_PKG_080000.lic.

• If the license daemon appears to have started correctly (which you 
should be able to determine from the ni.log file), try running 
lmstat to see if that program has the same problem as your 
application.

lmstat -a -c 

%MTXHOME%\MATRIXxLicenseManager\Licenses\MATRIXx_
PKG_080000.lic

Support Issues
When you make a support call, please be prepared to answer the following 
questions:

• What kind of machine is your license daemon running on? What 
version of the operating system is the application running on?

• What version of FLEXnet does the program use? Use the following 
command on your nilm vendor daemon and application:

%MTXHOME%\MATRIXxLicenseManager\bin\lmver 
%MTXHOME%\MATRIXxLicenseManager\bin\nilm.exe

• What error or warning messages appear in the log file? Did the daemon 
start correctly? Look for a message such as: 

server xyz started for: feature1 feature2.

• What is the output from running lmstat -a?

• Are you running other products which are also licensed by FLEXnet? 
National Instruments does not support combined license files.
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Troubleshooting License Manager Problems
This section lists areas of FLEXnet administration that have given 
customers difficulty in the past. Categories are Host ID Problems, 
Connection Problems, and Other Client Problems.

Host ID Problems
symptom When I run the license manager on my machine, it tells me it 

is the wrong host ID.

cause The vendor daemon checks the host ID listed on the server 
line in the license file; if it does not match the host ID of the 
machine it is running on, this message will be printed. 

Possible causes include: 

• You are trying to run the license daemon on a different 
machine from the machine the file was made for.

• The host ID of the machine you are running on changed 
(for example, the HP ID module was moved, or the CPU 
board was replaced).

• The host ID in the license file was modified.

solution Verify that the host ID of the machine where the vendor 
daemon (or node-locked client program) is being run matches 
the host ID specified in the license file (on the server line 
for the vendor, or on the feature line for a node-locked 
client). You can run the lmhostid program to see what 
FLEXnet thinks the host ID is. You cannot modify the host ID 
in the license file. If the host ID of your server machine 
changes, you will have to get a new license file from your 
software vendor.
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Connection Problems
symptom The application program (or lmstat) cannot connect to the 

server to check out a license.

cause The FLEXnet routines in the application are unable to make 
a TCP connection to the server and port specified in the 
license file. Possible reasons for this are: 

• The wrong license file is being referenced by the 
application program.

• The server machine specified in the license file is down.

• The vendor daemon specified in the license file is not 
running.

• The hostname in the license file is not recognized by 
the system.

• The network between the client machine and the server 
machine is down.

• TCP is not running on your machine.

solution Verify that the application is using the proper license file. 
Verify that the specified server machine is up and reachable by 
executing another command that uses TCP, such as rsh or 
rlogin, from the client to the server. Verify that the vendor 
daemon is running (you can use the ps command on the server 
to look for it). Examine the license log file to see if any 
problems are reported, particularly messages indicating that 
the vendor daemon has quit. Run lmstat -a from the server 
machine to verify that the vendor daemon is alive. Run 
lmstat -a from the client machine to verify the connection 
from client to vendor daemon across the network. Try using 
telnet hostname portnum where hostname and 
portnum are the same as on the server line in your 
license file.
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Other Client Problems
symptom When I run my application program (or vendor daemon), I get 

the error bad code.

cause Possible causes for this are: 

• The license file was modified (either the host ID on a 
server line or anything on the feature line was 
changed).

• The vendor used the wrong version of his license 
creation program to generate your license file (or there is 
a bug in that process).

solution You cannot modify the license file. If you need to change 
something in your license file, you must get a new license 
from National Instruments.

symptom When the second user tries to check out a license, the vendor 
daemon prints an error concerning Parameter mismatch 
in the log file and refuses the license.

cause The most likely cause of this problem is that you are 
simultaneously trying to run two different versions of the 
application program, and the software vendor has not 
specifically set up the new version for this kind of 
compatibility. Check the license server log file for a comm 
version mismatch warning message; this indicates that 
someone is running a V1.5 client with a V2.1 or later license 
server.

solution Run only the new version of the application (or only the old 
version).
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Other Server Problems
symptom When I start lmgrd, it says Retrying socket bind 

(address in use: port xxxx). 

cause The license server listens on the port xxxx that has already 
been used by another server program. 99.44% of the time, if 
it’s in use, it’s because lmgrd from NI or another vendor is 
already running on the port—or was recently killed, and the 
port isn’t freed yet. 

solution In the MATRIXx_PKG_080000.lic file NI has put 27000 at 
the end of the SERVER line as the port number. You can 
remove it to let lmgrd scan for a free port from 27000 to 
27009. You can also specify a port number selected by 
yourself for other concerns like farewell.

Caution The portscan feature of lmgrd is only available for FLEXnet v6+ licenses. 
You cannot drop the port numbers when configuring redundant servers.

symptom When I start up lmgrd, it says execl failed on my 
vendor daemon.

cause lmgrd uses execl to start each vendor daemon running. If 
there is a problem starting the vendor daemon, this message 
is output to the log file. This error is typically caused by 
one of the following: 

• There is no executable at the location referred to by the 
license file (and printed out in the log file). 

• The executable does not have the proper protection to be 
run (the file does not have the x bit set, or one of the 
directories in the path is not readable). 

• There was an error building the executable, and it cannot 
be run. 

• The executable is for a different machine architecture.

solution Verify that the path to the vendor daemon is absolute, and that 
it points to the executable program itself, not the containing 
directory (for FLEXnet v1.5). Ensure that the file exists by 
doing an ls -l of the vendor daemon filename(s) 
specified in the log file. Make sure you do this as the same 
user that started lmgrd. Verify that the file is executable. Run 
the vendor daemon directly from the command line. If the 
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vendor daemon is properly linked, it will tell you that it must 
be run from lmgrd; if it crashes or fails to execute, then it is 
not properly linked.

symptom The license server keeps reporting lost lock errors in the 
log file and exiting.

cause The lockfile is being removed by someone else. There could 
be another daemon running, or the system administrator (or a 
script) could have deleted the file.

solution Check to see if there is more than one copy of the daemon 
running. Check for more than one lmgrd running as well, 
since it will restart your vendor daemon when it is killed. If 
more than one lmgrd is running, kill them all, then kill any 
remaining vendor daemons and start one fresh copy of 
lmgrd. Check to see whether a shell script is running that 
cleans out tmp. If so, try modifying it so that it does not delete 
zero length files.

Daemon Log File
Daemons generate log files with DAEMON NAME messages where:

The log file, available as %MTXHOME%\MATRIXxLicenseManager\
bin\debug.log, can be used to:

• Inform users when they need to purchase additional application 
software licenses.

• Diagnose configuration problems.

• Diagnose daemon software errors.

DAEMON 
NAME

Either license daemon or the string from the DAEMON line 
that describes your daemon. In the case where a single 
copy of the daemon cannot handle all of the requested 
licenses, an optional underscore followed by a number 
indicates that this message comes from a forked daemon.

message The text of the message.
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Informational Messages
These messages are only informational and do not necessarily indicate an 
error or a problem.

Table 4-1.  Informational Messages and Meanings

Message Meaning

Connected to node. This daemon is connected to its peer on node node.

CONNECTED, master is name. The license daemons log this message when a 
quorum is up and everyone has selected a master.

DENIED: N feature to user 
(N licenses).

user was denied access to N licenses of feature.   

EXITING DUE TO SIGNAL nnn.
EXITING with code nnn.

All daemons list the reason that the daemon has 
exited.

EXPIRED: feature. feature has passed its expiration date.

IN: feature by user 
(N licenses).

user has checked back in N licenses of feature.

License Manager server started. The license daemon was started.

Lost connection to host. A daemon can no longer communicate with its peer 
on node host, which can cause the clients to have 
to reconnect, or cause the number of daemons to go 
below the minimum number, in which case clients 
may start exiting. If the license daemons lose the 
connection to the master, they will kill all the vendor 
daemons; vendor daemons will shut themselves 
down.

Lost quorum. The daemon lost quorum, so it will only process 
connection requests from other daemons.

MULTIPLE xxx servers running. 
Please kill, and restart license 

daemon.

The license daemon has detected that multiple 
copies of vendor daemon xxx are running. The user 
should kill all xxx daemon processes and restart the 
license daemon.

OUT: feature by user (N licenses). user has checked out N licenses of feature.

RESERVE feature for HOST name.
RESERVE feature for USER name.

A license of feature is reserved for either user 
name or host name.
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Configuration Problem Messages

REStarted xxx (internet port nnn). Vendor daemon xxx was restarted at internet port 
nnn.

Retrying socket bind 
(address in use).

The license servers try to bind their sockets for 
approximately 6 minutes if they detect “address in 
use” errors.

Selected (EXISTING) master node. This license daemon has selected an existing master 
(node) as the master.

SERVER shutdown requested. A daemon was requested to shut down through a 
user-generated kill command.

[NEW] Server started for: 
feature-list.

A (possibly new) server was started for the features 
listed.

Shutting down xxx. The license daemon is shutting down the vendor 
daemon xxx.

SIGCHLD received. Killing child 
servers.

A vendor daemon logs this message when a 
shutdown was requested by the license daemon.

Started name. The license daemon logs this message whenever it 
starts a new vendor daemon.

Trying connection to node. The daemon is attempting a connection to node.

Table 4-2.  Configuration Problem Messages and Meanings

Message Meaning

hostname: Not a valid server 
host, exiting

This daemon was run on an invalid hostname.

hostname: Wrong hostid, exiting The host ID is wrong for hostname.

BAD CODE for feature-name The specified feature name has a bad encryption 
code.

CANNOT OPEN options file file The options file specified in the license file could not 
be opened.

Table 4-1.  Informational Messages and Meanings (Continued)

Message Meaning
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license daemon: lost all 
connections

This message is logged when all the connections to 
a daemon are lost, which often indicates a network 
problem.

lost lock, exiting Error closing lock file.

Unable to re-open lock file The vendor daemon has a problem with its lock file, 
usually because of an attempt to run more than one 
copy of the daemon on a single node. Locate the 
other daemon that is running via a ps command, and 
kill it with kill -9.

NO DAEMON line for daemon The license file does not contain a DAEMON line for 
daemon.

No license service found The TCP license service did not exist.

No license data for feat, feature 
unsupported

There is no feature line for feat in the license file.

No features to serve! A vendor daemon found no features to serve. This 
could be caused by bad data in the license file.

UNSUPPORTED FEATURE request: 
feature by user

The user has requested a feature that this vendor 
daemon does not support. This can happen for a 
number of reasons: the license file is bad, the feature 
has expired, or the daemon is accessing the wrong 
license file.

Unknown host: hostname The hostname specified on a SERVER line in the 
license file does not exist in the network database.

NO DAEMON lines, exiting The license daemon logs this message if there are no 
DAEMON lines in the license file. Since there are no 
vendor daemons to start, there is nothing to do.

NO DAEMON line for name A vendor daemon logs this error if it cannot find its 
own DAEMON name in the license file.

Table 4-2.  Configuration Problem Messages and Meanings (Continued)

Message Meaning
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Daemon Software Error Messages

Table 4-3.  Daemon Software Error Messages and Meanings

Message Meaning

select: message An error in a select system call was detected.

Server exiting The server is exiting. This is normally due to an 
error.



© National Instruments Corporation A-1 System Administrator Guide (Windows)

A
Technical Support and 
Professional Services

Visit the following sections of the National Instruments Web site at 
ni.com for technical support and professional services:

• Support—Online technical support resources at ni.com/support 
include the following:

– Self-Help Resources—For answers and solutions, visit the 
award-winning National Instruments Web site for software drivers 
and updates, a searchable KnowledgeBase, product manuals, 
step-by-step troubleshooting wizards, thousands of example 
programs, tutorials, application notes, instrument drivers, and 
so on.

– Free Technical Support—All registered users receive free Basic 
Service, which includes access to hundreds of Application 
Engineers worldwide in the NI Discussion Forums at 
ni.com/forums. National Instruments Application Engineers 
make sure every question receives an answer.

For information about other technical support options in your 
area, visit ni.com/services or contact your local office at 
ni.com/contact. 

• Training and Certification—Visit ni.com/training for 
self-paced training, eLearning virtual classrooms, interactive CDs, 
and Certification program information. You also can register for 
instructor-led, hands-on courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 
technical resources, or other project challenges, National Instruments 
Alliance Partner members can help. To learn more, call your local 
NI office or visit ni.com/alliance.

If you searched ni.com and could not find the answers you need, contact 
your local office or NI corporate headquarters. Phone numbers for our 
worldwide offices are listed at the front of this manual. You also can visit 
the Worldwide Offices section of ni.com/niglobal to access the branch 
office Web sites, which provide up-to-date contact information, support 
phone numbers, email addresses, and current events.
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